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نامه بتن ایران ( در صورت اعمال بر اساس آیینTorsional Constantپیچشی تیرهای بتنی ) خوردگیترکمیزان 

 )آبا( چقدر است؟

1)5110                       2 )51.0                                . )510                        4 )510 

1 

 ود ندارد؟وج Etabsافزارنرم در زیر قابلیت كدام

 فلزی، بتنی و دیوار برشی هایسازهطراحی (1

 طراحی تیرهای سقف مرکب(2

 فولادی سرد نورد شده هایسازهطراحی (.

 زمانی تاریخچهتحلیل استاتیكی خطی و غیرخطی، دینامیكی طیف پاسخ و (4

2

 ؟ستینزیر در مورد سقف صلب درست  یهاجملهاز  کیكدام

 داخلی تغییر شكل ندهد. یهاتنشرهای وارده و سقف کاملاً صلب سقفی است که تحت با(1

 فرض کرد که سقف مربوطه صلب است. توانمیبكار ببریم بدون محاسبات  ایسازهرا هر در  بلوکرچهیتاگر سقف (2

 .شودمیاز سقف صلب جهت توزیع نیروی جانبی مابین عناصر مقاوم باربر استفاده (.

 .کنیممیكان تمام نقاط سقف را به مرکز جرم آن طبقه وابسته در حقیقت تغییر م کنیممیوقتی سقفی را صلب (4

3

 حداقل و حداكثر آرماتور افقی و قائم در دیوار برشی چه مقدار است؟

 درصد حداکثر 2درصد حداقل و  5120(1

 حداکثر درصد . و حداقل درصد 210(2

 هاوصله محل در حداکثر درصد 6 و حداقل درصد 5120(.

 درصد 210 حداکثر و حداقل(4

4

 ؟شودمیآرماتور افقی در دیوار برشی بر اساس كدام نیرو محاسبه 

 و محوری خمشی( 4               خمشی و برشی( .                برشی( 2ی               خمش(1

5

ر ه توانمیو  شودمیطراحی دیوار برشی آرماتورهای قائم به صورت دلخواه در مقطع توزیع  هایحالتدر كدامیک از 

 شکلی را برای مقطع دیوار برشی در نظر گرفت؟

1)uniform                                    . )General

2)simplified T&C                       4)advanced           

6

 از باید همواره و نمود ادهاستف check  از حالت توانمیجهت تعریف كدامیک از اعضای سازه ن آرمهبتن هایسازهدر 

 كرد؟ استفاده design حالت

      برشی دیوار و ستون( 4ر                 تی( .                     برشی دیوار( 2                    ستون(1

7

 ماتور مجاز در تیرها چه مقدار است؟رحداكثر درصد آ

 درصد 20/2 (4           درصد 4 (.           درصد               .( 2               درصد 0/2(1

8

تیر و ستون در سازه با حركت جانبی مهار نشده به ترتیب چه مقدار  آرمهبتندر مقاطع  خوردگیترکمقدار ضریب اثر 

 است؟

1)510  1510               2 )510  151.0                     . )51.0  1510       4 )51.0  151.0 

9

برنامه را كه  فرضپیشمتوسط طراحی كنیم با چه دستوری  یریپذشکلبا  آرمهبتن یاسازهبخواهیم  كهورتیدرص

 ؟دهیممیزیاد است تغییر  پذیریشکل
1)Design / Concrete design / view rivise over write  
2)option / preference/ concret frame design

.)design / concert design / display design info

4)design/ over write design procedure
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 ؟ستیندر مورد سیستم دوگانه فولادی كدام گزینه زیر درست 

 .دیآیم این سیستم از ترکیب قاب خمشی و مهاربند یا دیوار برشی بوجود(1

 %20و قاب خمشی برای  نیروی زلزله %155مهاربند یا دیوار برشی برای  علاوهبهدر طراحی این سیستم قاب خمشی (2

 .شودمینیروی زلزله طراحی 

 از سیستم خمشی مشابه است. تربزرگمقدار ضریب رفتار این سیستم (.

 سیستم دوگانه سیستمی است که در یک جهت قاب خمشی و در جهت عمود بر آن مهاربند یا دیوار برشی باشد.(4

11

 ؟ میكنیمنه استفاده بر روی المان سطحی از كدام گزی یانقطهجهت اعمال بار 

1)Assign / Area loads/ point  
2)define / Area loads / point

.)Assing / Area loads/ uniform

 بر روی المان سطحی تعریف نشده است. یانقطهدستوری جهت اعمال بار (4

12

ر نمایش داده شود؟توپ ،ایصفحه المان كه شودمیفعال كردن این گزینه باعث set building view optionدر 

1)object fill2 )object edge. )object shrink4 )object plate

13

 ؟نیمكمیمقطع دیوار برشی را تغییر دهیم از كدام دستور استفاده  افزارنرمبخواهیم بدون باز كردن قفل  كهدرصورتی
1)Design / shear wall  Design / Define pier…
2)Design / shear wall Design / Assign pier… 
 تغییری در مقطع دیوار برشی داد . توانمیبدون باز کردن قفل ن(.
4)Assign  / shell / Area/ pier label

14

 . كنیممیجهت اعمال بار گسترده بر روی اعضای خطی از كدام دستور استفاده 
1)Assign / frame/ line/ loads/ uniform

2)Assign / frame/ line/ loads/ distributed

.)define / frame/ line/ loads / uniform  
4)define / frame/ line / loads /distributed  

15

 استفاده كرد؟ توانمیتیر لانه زنبوری را در كدام حالت زیر 

 در سیستم قاب خمشی( .              8و  0تیر اتصال مهاربند  عنوانبه(1

 تیر فرعی سقف کامپوزیت عنوانبه( EBF4تیر اتصال مهاربند عنوانهب(2

16

 ؟شودمیبرای مشاهده مساحت میلگرد مورد نیاز تیرها از ابزار كدام منو استفاده 

1)Design2 )Assign. )Display4 )Define

17

 ؟ كنیممیجهت معرفی مواد، مقاطع، بارها، تركیبات بارگذاری از كدام منو استفاده 

1)Display2 )Assign. )Define4 )option

18

 ار است؟چه مقدAIIخارج از محل وصله برای آرماتور  هاستونحداكثر درصد آرماتور مجاز 

 درصد 8( 4                         درصد 4( .                     درصد 6( 2                      درصد .(1

19

 ؟ كنیممیمورد نظر چه دستوری را اجرا  یهاسقفبرای اختصاص سقف صلب برای سقف طبقات پس از انتخاب 
1)Assign / joint/ point / Diaphragm

2)Assign / shell/ Area/ Diaphragm

.)Define / Diaphragm 
4)set building view option/ Diaphragm extend 

21

 ؟كنیممیجهت مشاهده و ساخت فایل متنی كه شامل اطلاعات ورودی و خروجی سازه باشد از چه دستوری استفاده 
1)display / show table / Building data

2)file / print table / summery report

.)file / print table /Analyze out put

4)display / show table / Analyze vesult

21

https://sazeplus.com/
https://sazeplus.com/


3   

گزارش دهد،اگر بخواهیم از  18186را با عدد  هاستونمقدار لازم آرماتور برشی برای  افزارنرم كهدرصورتی

 برشی رهایآرماتو مابین فاصله حداكثر تعیین مطلوب است كنیم استفاده 11 شماره آرماتور  عدد  3

1)1210                          2) 10                           .  )0                                 4 )15  

22

 ؟رودمی بکار منظوری چه به  Make Auto select section nullدستور 

 ایجاد لیست طراحی خودکار فولادی(1

 ی خودکار پس از یكسان شدن مقطع تحلیل و طراحی خارج کردن موضوعات انتخاب شده از حالت طراح(2

 ایجاد لیست طراحی خودکار بتنی(.

خارج کردن موضوعات انتخاب شده از حالت طراحی خودکار قبل از یكسان شدن مقطع تحلیل و طراحی(4

23

 خروج از مركز اتفاقی در تعریف نیروی زلزله در چه صورتی باید تعریف شود. 

 طبقه 0متر یا بالای  18بالای  هایساختمان (.                          قهطب 0بالای  هایساختمان(1

طبقه یا نامنظم 0متر یا  18بالای  هایساختمان( 4                              متر 18 بالای هایساختمان(2

24

 /Assign/Frameدستور  كهدرصورتیفرض كنیم تمامی اعضای سازه در حالت انتخاب هستند 

line/loads/uniform  افتدیمرا اجرا كنیم. چه اتفاقی . 

 .شودمیبر روی کلیه اعضای سازه بار گسترده اعمال (1

 .شودمیو دیوارهای برشی( بار یكنواخت اعمال  هاسقففقط بر روی اعضای سطحی )(2

 .شودمیسقف بار یكنواخت اعمال  هایالمانفقط بر روی (.

 مال نخواهد شد.در این حالت انتخاب، هیچ باری اع(4

25

ز كمتر ا بافاصلهو تیرها )ناحیه بحرانی( بر اساس .....  هاستونآرماتور برشی در ابتدا و انتهای  آرمهبتن هایسازهدر 

 ؟شودمیسایر نقاط تعبیه 

دس محاسبر مهننظ( 4              افزارنرمنتایج طراحی ( .         نامهآئینضوابط ( 2        نتایج طراحی دستی(1

26

معرفی كنیم این كار را با دستور ................  افزارنرمبرای تحلیل دینامیکی به روش طیفی ابتدا باید طیف بازتاب را به 

 . دهیممیانجام 

1)define / tim history / function. )Assign / response spectrum function

2)define / response spectrum  function              4 )define / static load cases

27

تنش زیر پی در برخی نقاط بیشتر از تنش مجاز خاک باشد، افزایش ضخامت پی در   SAFEافزار اگر پس از طراحی نرم

و میمؤثرآن نقاط   توان در آن قسمت.........

 استفاده نمودبه ضخامت پی افزود و یا از شمع –است (1

 به ضخامت و یا عرض پی افزود–است (2

 از شمع استفاده نمود-نیست (.

 به عرض پی افزود و یا از شمع استفاده نمود–نیست (4

28

 ؟نیستمتنی  هایخروجیزیر جزو  هایگزینهاز  یکكدام

1)File / print table / in put. )File / print table / shear wall design 

2)File / print table / Analyze out put4 )File / print table / Reaction

29

 چیست؟Master storyمنظور از 

 .دهدمیمرکز جرم طبقه را نشان (1

 .کنیمیمطبقه مبنا که جهت سرعت در بارگذاری و اختصاص خصوصیات مقاطع تعدادی از طبقات را مشابه آن مدل (2

 .دهدمیمحل وصلة ستونهای طبقه را نشان (.

 طبقه خرپشته(4

31
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 ؟شودمیاز ابزار كدام منو استفاده  هاستونبرای مشاهده نسبت تنش 

1)Design2 )Assign. )Display4 )Define

31

 ؟شودمی استفاده، مركزجرم طبقه، تركیبات بار و مدهای نوسان از كدام دستور نسبی طبقاتجهت مشاهده تغییرمکان
1)display / show table / building out put

2)display / show table / displacement 
.)display / show table / Frame out put

4)display / show table / Building data

32

 انتخاب كنیم.  option/prerefrenceبتن ایران كدام گزینة زیر را باید از منوی  امهننیآئبر اساس  هجهت طراحی ساز

1)ACI                        2 )CSA. )AISC                       4) UBC70 

33

 .تعریف شده است Etabs افزارنرم)موضوع( در  object  چند نوع

 سطحی–خطی ( .                سطحی– خطی– اینقطه(1

 غیرخطی–خطی ( 4     حجمی– سطحی–خطی  -اینقطه(2

34

 باشد.  شودمیفولاد ایران طراحی  نامهآئیند تركیب بار یک ساختمان فولادی كه بر اساس توانمیگزینه  كدام

1)DL + LL + Ex. )5100 (DL + LL+ Ex) 

2)DL + LL + Ex + Ey4 )1150 DL + 11200LL + 114Ex 

35

 ؟كنیممیمقطع عضوی را تغییر بدهیم از چه دستوری استفاده  افزارنرمبخواهیم بدون باز كردن قفل  كهدرصورتی

1)Assign / Frame / line / Frame section       . )Design / over write Frame design procdure

2)Design / change  design section4 )هیچكدام 

36

 ؟شودمیبه چه منظوری استفاده  display / show member force/ stress diagramاز دستور 

 هاآنجهت مشاهده نیروهای داخلی اعضای خطی و نمودارهای (1

 گاهتكیه العملعكسجهت مشاهده نیروهای (2

 رو و تنش در اعضاء سطحیجهت مشاهده نی(.

 کلیه موارد(4

37

در مشاهده نتیجه تفصیلی طراحی یک عضو فولادی یا بتنی نسبت تنش به صورت مجموع سه عدد ) به طور 

 چیست؟ فوق عدد سه از منظور. شودمی داده نمایش(    1821+ 1811+  1861= 1892مثال

 نسبت تنش بار محوری + خمشی + برش(1

 + خمش حول محور ضعیف + خمش حول محور قوینسبت تنش بار محوری (2

 نسبت تنش بار محوری برای بار مرده + بار زنده + زلزله(.

zو  y وx نسبت تنش بار ناشی از خمش حول محورهای(4

38

 ؟شودمیبا چه پیوندی ذخیره  Etabs افزارنرمفایل اصلی 

1)F2K                         2 )FDB . )EDB                     4) SDB

39

 ؟رودمیكدام گزینة زیر بکار ن  Defineدر دستور

 معرفی جرم سازه( .             معرفی ترکیبات بارگذاری(1

 معرفی طیف بازتاب جهت تحلیل دینامیكی( 4               طراحی نامهآئینمعرفی (2

41

 ؟نیستم جمله درست در مورد مدهای نوسان ساختمان سه بعدی كدا

 .دارد دورانی نوسان مد یک و انتقالی نوسان مد 2 طبقه هر ازای به هر سازه (1

 مدهای نوسان اول نسبت به مدهای بالاتر زمان تناوب بیشتری دارند.(2

 فعال کرده باشیم.analyzeرا در منوی set Dynamic parametersکه گزینة  شودزمانی نمایش مینوسان  مد(.

 .کنندمینوسان سازه با تغییر ترکیبات بار طراحی تغییر مدهای (4

41
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 ؟كنیممیو تیرها از كدام دستور استفاده  هاستونفلزی جهت تنظیم پارامترهای طراحی مهاربندها،  سازهدر طراحی 
1)option / prerefrence/steel frame design

2)Design / steel Frame design / view revise over writes

.)Design / over write Frame Design procedure

4)Design / steel  joist design

42

 .باشد ACIبتن آمریکا  نامهآئینهفت طبقة نامنظم تحت  آرمهبتند تركیب بار طراحی سازة توانمیزیر  گزینه كدام

1)114DL + 110LL + 1180 Exp 

2)1150 DL + 11200LL + 114 Exp + 5142Ey 

.)DL + LL + Exp + 51. Ey 

4)1150DL + 11200 LL + 114Exp

43

 ؟باشدیمتعداد درجات آزادی یک گره نامقید در یک سازة سه بعدی چه تعداد 

صفر (4                               4(  .                            .( 2                                    6(1

44

 .باشدیمكدام جمله نادرست  هاستونای در رابطه با قیود تکیه گاهی پ

 .کندمیاتصال پای ستون را مفصلی فرض  افزارنرم فرضپیش(1

 .کنیممی استفاده Assign / joint/restraintجهت اختصاص قیود تكیه گاهی پای ستون از دستور (2

 .شوندمی در اتصال صلب پای ستون )هر دو جهت صلب( تمام درجات آزادی دورانی و انتقالی مقید(.

  .کنیممیدر اتصال مفصلی پای ستون )هر دو جهت مفصلی( درجات آزادی دورانی و انتقالی را آزاد (4

45

 زیر در مورد تعریف مقاطع بتنی صحیح است.  هایگزینهاز  یکكدام

یم از مقطع مربع و مستطیل استفاده کنیم.توانمیفقط  هاستونبرای (1

 .کنیممیرا انتخاب Reinforced to be check  در تعریف مقطع تیرها حالت(2

 .شودمیپوشش بتن روی آرماتور از مرکز آرماتور طولی در نظر گرفته (.

عدد باشد. 6( نباید بیش از  2،.در هر جهت ) هاستون تعداد آرماتور معرفی شده در(4  

46

 صحیح نیست؟ Etabs افزارنرمكدامیک از جملات زیر در مورد 

 داریم. یانقطهفقط سه نوع المان خطی و سطحی و  افزارنرمدر این (1

 .شودمیبا ضوابط مهاربندها طراحی  شودمیهر عضو مایل خطی که در صفحه قائم ترسیم (2

 .شودمیدیوار برشی در نظر گرفته  عنوانبههر عضو قائم سطحی (.

 کندیممال به طور خودکار نیروی شلاقی زلزله را محاسبه کرده و به سازه اع افزارنرم(4

47

 چه كاربردی دارد؟ Edit/ Edit Grid lineدر منوی glue joint to lineگزینة 

 جدا کردن خطوط شبكه از خطوط ترسیم شده( .                                    کردن خطوط شبكه جاجابه(1

کردن خطوط شبكهاکپ (4             سباندن خطوط شبكه به خطوط ترسیم شدهچ(2

48

 ست؟به زمین چی هاستوندر اتصال  Etabs  افزارنرم فرضپیش

 دارد نظر مورد سازه به بستگی( 4                 غلتكی( .(  گیردار                     2              مفصلی(1

49

 و اولین كاری كه باید انجام دهیم چیست؟ نیترمهم 9سری   Etabsافزارنرمپس از باز كردن 

 شبكه خطوط رسم (4       سازه نوع تعیین( .               تنظیم واحد( 2     تعریف مقاطع(1

51

 مقدار است؟ چه آندارای مقطع فشرده بوده و مهار جانبی داشته باشد مقدار تنش مجاز  Iتیری با مقطع  كهدرصورتی

1)516Fy            2 )5166Fy. )5100Fy4 )514Fy 

51

 چیست؟ Null Areasمنظور از Etabs افزارنرمدر 

 تعریف شده توسط کاربر ایصفحهموضوعات ( .                              موضوعات دارای یک خصوصیت(1

 افزارنرمتعریف شده در  ایصفحهوضوعات م( 4                          فاقد خصوصیت ایصفحهوضوعات م(2

52
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 دایره سبز كوچک در انتهای اعضا نمایانگر ..... است.

                  ریفن ( اتصال4         اتصال نیمه گیردار ( .                   اتصال مفصلی( 2                اتصال صلب(1

53

 چیست؟building view optionدستور درEnd Releaseكاربرد گزینه 

  اینقطهمشاهده فنرهای ( .               شاهده آزادسازی انتهای اعضام(1

 اینقطهایجاد فنرهای ( 4                  ایجاد آزادسازی انتهایی اعضا(2

54

 كنیم؟می استفاده Deckكامپوزیت از كدام گزینة  جهت تعریف سقف

1)Filled Deck                     .)  solid slab

2)unfilled Deak4   )steel deck

55

 چیست؟ Edit reference planesكاربرد دستور

 ایجاد طبقه مجازی در تراز مورد نظر ( .                    ویرایش ارتفاع طبقات و تراز طبقات(1

 به طبقات ساختمان یاطبقهاضافه کردن  (4                                     تعریف طبقات مشابه(2

56

 ؟كنیممیاستفاده  ایصفحهاز موضوعات  یکكدامجهت تعریف یک دال دو طرفه از 

1)slab                        2 )Deck                      . )plank 4 )Deck, slab

57

 . كنیممی استفاده  زیر را هایگزینه از یکكدامجهت تعریف سقف تیرچه بلوک 

1)Filled Deck2  )unfilled Deak            . )solid slab             4 )steel  deck

58

Splice point در story data  .چه كاربردی دارد 

 .دهدمیطبقات مشابه را نشان ( .                       نشان دهنده نقاط اتصال تیر به ستون است.(1

 .دهدمیمرکز سختی طبقه را نشان ( 4            .رودمیدر صورت وجود وصله در ستونهای طبقه بكار (2

59

  نیستم جمله درست در رابطه با محورهای اصلی و فرعی كدا

 .شودمی( در طول عضو و از ابتدا به انتهای عضو تعریف 1محور محلی )(1

 .باشدمی( majorمحور قوی )2( وminorمحور ضعیف ) .محور محلی (2

 .باشندمی zو yو xکه به ترتیب موازی محورهای اصلی  باشدمی 2،1،.هر گره دارای محورهای محلی(.

  .باشدمیستگاه مختصات راستگرد دستگاه مختصات سراسری یک د(4

61

قبلی استفاده كنیم  یهامدل( از خصوصیات تعریف شده new modelدر صورتی كه بخواهیم در ساخت مدل جدید )

 را باید انتخاب كنیم؟ یانهیگزچه 

1)new model / No                                . )new model / defult

2)new model / choose.edb                   4 )new model / previous model

61

 ؟رودمیجهت اعمال نسبت طول مهار نشده جانبی بال فشاری تیرها كدام گزینة زیر بکار 
1)Effective length factor k major

2)unbraced  length  Ratio major

.)Effective  length  factor k minor

4)unbraced  length  Ration  minor Ltd

62

 ؟رودمی بکار منظوری چه به Assign/shell Area/pier labelدستور 

اختصاص مقاطع برای دیوارهای برشی (.                             بارگذاری دیوار برشی(1

نامگذاری ستونهای متصل به دیوار برشی( 4                            نامگذاری دیوار برشی (2  

63

 تیرچه باشد. برجهتزیر جهت پخش بار باید عمود  یهاسقفاز  یکكدامدر 

مشبكی دال( 4                   طرفهکیدال ( .            سقف کامپوزیت( 2           سقف تیرچه بلوک(1

 

64
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 ؟شودمیمقررات ملی ایران چه مقدار در نظر گرفته  11مطابق مبحث  X مهاربند  مؤثرمقادیر ضریب طول 

    510 صفحه خارج کمانش و  510کمانش داخل صفحه(1

 5180و کمانش خارج صفحه 1کمانش داخل صفحه(2

 1و خارج صفحه  1کمانش داخل صفحه (.

 510و کمانش خارج از صفحه 510کمانش داخل صفحه (4

65

 چیست؟ Divid lineكاربرد دستور 

 تقسیم کردن خطوط( .                         اتصال خطوط(1

 جابجا کردن خطوط( 4                  دادن خطوط امتداد(2

66

splice height درstory data چه كاربردی دارد؟ 

 .دهدمیرا نشان  طبقهمینارتفاع طبقه یا (1

 .دهدمیطول خالص ستون را نشان (2

 .دهدمیارتفاع طبقات مشابه را نشان (.

 .رودمیصله از کف طبقه بكار جهت مشخص نمودن فاصله محل و هاستوندر صورت وجود وصله در (4

67

 ؟رودمیبه كار  هالبهكردن نقاط، خطوط و  فیردهمكدام دستور برای 

1)Align points / lines/ Edges                             . )Merge points / lines/ Edges

2)Edit points/ lines / Edges4 )Extend line objects

68

 . رودیمبه چه منظور بکار  exportو  import دستور Fileدر منوی

 دیگر هایبرنامهبه Etabs موجود در هایفایلو یا صادر کردن Etabsمختلف به  یهالیفا واردکردن(1

 متنی مورد نیاز برنامه هایفایلساختن (2

 قبلی جهت استفاده از مشخصات تعریف شده در آن هایمدلاستفاده از (.

 موجود هایفایلاز  هاآنتوصیف مقاطع و فراخوانی (4

69

 كدام دستور را باید اجرا كرد؟ Etabs افزارنرمها در  Errorها و  warnigهده جهت مشا
1)File/ input data

2)prerefrence / option/ last Analyzis run log 
.)file / last Analyzis run log

4)display / Error and warning

71

 Ev( بار قائم زلزله wall( نصف بار طبقه آخر )adDe( بار مرده ) liveبرای یک ساختمان مسکونی كه شامل بار زنده )

x و بار افقی زلزلهE  وyE  است.  افزارنرمجرم معرفی شده به  دهندهباشد كدام گزینه نشان 

1)Dead+ live                                                   .) Dead + 512 wall + live        

2)Dead+ live + wall                                     4) Dead + wall + 512 live 

71

 از دستورات زیر وجود ندارد؟ یکكدام Editدر منوی 

 مشاهده آخرین نتایج طراحی( .                    حذف و اضافه کردن یک طبقه به سازه(1

 (mergeچسباندن دو عضو جدا از هم )( 4                               (move) هاالمانجابجا کردن (2

72

 ؟شودمیه دیوارها )مش( از چه دستوری استفاد یبندمیتقسبرای 

1)Edit/ mesh Area          . )Edit / mesh wall for opening

2)Assign / mesh wall           4 )Edit/ merge Area  

73

 ؟شودمیدیوارها )مش( از چه دستوری استفاده  یبندمیتقسبرای 

.)Edit/ mesh Area                              . )Edit / mesh wall for opening

4)Assign / mesh wall           4 )Edit/ merge Area  

74
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 ؟شودمیدر سازه از كدام منو استفاده  پی دلتاو اعمال اثر  یسازفعالجهت 

1)Analyze2 )Design                       . )option                        4 )define

75

 كنیممیتعریف  shell رفتار المان را ایصفحهاز موضوعات  یکكدامدر

       1 ) Slab                      2 )plank. )wall4 )Deck

76

Etabs افزارنرمبرای تعریف مقاطع مستطیل در 

 

 ؟شودمی استفاده گزینه كدام از 
1)define / import / rectangular 
2)Assign / add/ rectangular

.)define / add / rectangular

 
 

4)define/ add / General

77

 ؟ رودمی بکار منظوری چه به End offsetدستور 

 جهت آزادسازی انتهای اعضای خطی(1

 جهت اعمال بار در دو انتهای اعضا خطی(2

 جهت اعمال ناحیه صلب انتهای اعضا خطی(.

 جهت اعمال ناحیه صلب انتهای اعضا سطحی(4

78

 ؟رودمیریزی( المان سقف بکار  رگیری )جهت تیركدام گزینة زیر برای تغییر زاویه قرا
1)Assign / shell Area / local Axes

2)define/ shell Area/ local  Axes

.)view/ change local Axes

4)define / add / General 

79

 ؟شودمیایران از كدام تركیب بار استفاده  نامهآیینطبق  ∆-Pهای بتنی برای محاسبه در طراحی ساختمان

1)114DL+110LL

2)1120DL+110LL

.)DL+LL
4)DL+512LL 

81

 ؟شودمیآمریکا از كدام تركیب بار استفاده  نامهآیینطبق  ∆-Pهای بتنی برای محاسبه در طراحی ساختمان

1)114DL+110LL

2)1120DL+110LL

.)DL+LL
4)DL+512LL 

81 

 شودمیهای سازه از ابزار كدام منو استفاده جهت دیدن تغییر شکل

1)View                                  . )Display

2)Assign4 )Define

82 

 مشاهدهمشاهده كنیم امکان  display/ show loadsا از منوی به سازه ر شدهاعمالدر صورتی كه بخواهیم بارهای 

 زیر وجود ندارد؟ هایگزینهاز  یکكدام

 نیروهای داخلی اعضا( .                              خطی ، سطحی، اینقطهبارهای (1

 یروی زلزله وارد بر سقف صلبن( 4                         تحت ترکیبات بار شدهاعمالارهای ب(2

83 

؟شودمیاز كدام دستور استفاده  افزارنرم صفحهمشاهده در  یهاپنجرهجهت تنظیم تعداد 

1)view / window2 )display / window       . )Edit/ window4 )option / windows

84 

 كنیم؟حیه صلب انتهایی از كدام دستور استفاده میجهت اختصاص نا

1)Frame Releases2 )Frame Section. )Pier lable    4 )End (length) offset

85 
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 شودمیای از كدام دستور استفاده برای اختصاص جهت محورهای محلی موضوعات صفحه

1)Shell/Area> Local Axes                        . )Shell Area> Opening

2)Shell/Area> Pier Label4) Shell Area> Diaphragms

86 

 ؟شودمیبرای اختصاص بار گسترده به صفحات از كدام دستور استفاده 

1)Frame/line load>point        .) Frame/line load>Temperatural

2)Frame/line load>Distributed4) Shell/Area>uniform

87 

 ؟شودمیكدام پارامتر استفاده ن گیریاندازهبرای  Measureاز دستور 

 زاویه (4                         ابعاد مقطع( .                  مساحت( 2ط                طول خ(1

88 

 .كنیممیجهت تعریف یک نمای جدید دلخواه از كدام دستور استفاده 

1)Define / Drow Development elevation. )ption / add new elevation

2)Drow / Drow Development elevation4 )نیست پذیرامكاننمای جدید  فعریت. 

89 

توسط كاربر را در ارتفاع سازه  شدهمحاسبهبارگذاری زلزله در صورتی كه بخواهیم نیروهای زلزله  هایحالتدر معرفی 

 . كنیممیتوزیع كنیم از كدام گزینه استفاده 

1)user coefficient       2) user load        . )none              4 )UBC 70 

91 

 ( كرد؟ import) فراخوانی Euro.proاز فایل  توانمیاز مقاطع زیر را ن یکامكد

1)Double Angle2) Tee         . )Angel         4 )Double  Channel

91 

 ؟شودمیاز كدام تركیب بار استفاده  ∆-Pهای فولادی برای محاسبه در طراحی ساختمان

1)114DL+110LL                       . )DL+LL

2)1.20DL+110LL                     4 )DL+512LL 

92 

 زیر است؟ هایروشاز  یکكدامبرای معرفی یک مقطع مركب از چند پروفیل و ورق روش  ترینمطمئن

1)import / General      2 )Add/ General       . )Add/ sd section   4 )import / sd section

93 

 . كنیممی اجرا را دستوری چه طبقات سقف به  شدهاعمالجهت مشاهده بارهای 

1)display / show loads / Frame/ line. )Assingn / Area loads

2)display / deformed shape4) display / show loads / Area

94 

و  4یب تبه تر 3و  2در تعریف مقطع ستون مستطیل برای یک سازة بتنی اگر تعداد آرماتورهای معرفی شده در جهت 

 باشد تعداد آرماتورهای بکار رفته در مقطع چند عدد است؟ 5

1)12                                 2 )25                                . )14                            4 )16

95 

 ؟شودمیبرای دیوار برشی كدام حالت در قسمت نوع صفحه انتخاب 

1)Shell2  )Membrane                .  )Plate4 )هیچكدام

96 

 ؟شودمیی معرفی مقطع دیوار برشی از كدام دستور استفاده برا

1)Section Designer.) Wall/slab Section

2)Frame Section4) هیچكدام

97 

 دهد؟اگر مقطع دیوار در بعضی طبقات جواب ندهد با چه پیامی آن را نشان می

1)D/S                        2 ) P.M   .  )L/E                   4) O/S

98 

 ؟رودمیزیر جهت طراحی دیوار برشی بکار ن هایروشاز  یکكدام Etabs افزارنرمدر 

1)Simpilified C and T                   . )General  Reinforcing…

2)uniform Reinforcing…                        4) .D Design…  
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 به چه معنا است؟  Choose.edbدر هنگام ایجاد فایل جدید در قسمت پیغام ظاهر شده گزینه 

 فرضپیشاستفاده از حالت (1

Defaultاستفاده از حالت (2

 توسط کاربر تهیه شده است. قبلاًاستفاده از تعریفات فایلی که (.

بخصوص نامهآییناستفاده از (4

111 

 دارد؟در این منو وجود  Replicateدستور 

1)Define2 )File                          . )Edit                        4) Draw

111 

 چیست؟  Draw Line (Plan,Elve,3D)كاربرد دستور 

 .و  2زینه گ( 4            ترسیم تیر و ستون( .             ترسیم بادبند( 2         ترسیم اعضای سقف و دیوار(1

112 

 ؟كنیممیدام گزینه استفاده جهت ترسیم بادبند هشتی از ك

1)Inverted V                     2) X                          .) V                        4) Eccen Back

113 

 ؟نیستكدام گزینه جزء مشخصات تعریفی بتن 

 مدول الاستیسیته( .                  1ممان اینرسی حول محور (1

 جرم واحد حجم( 4                                  ضریب پواسون(2

114 

 ؟شودمینظور جهت تعریف بتن صفر كدام گزینه صفر م

 وزن واحد حجم( .                                جرم واحد حجم(1

.و  1گزینه ( fc                             4مقاومت فشاری (2

115 

استفاده   شودمیجهت تعریف حالات بار استاتیکی از دستور.........

1)Static load cases                              . )Response Spectrum function

2)Time history function4 )Response Spectrum Case

116 

 است؟ یافتهكاهشكدام مورد معرف بار زنده 

1)Super Dead2  )Live  .  )Relive              4 )Quake

117 

 كنیممیجهت تعریف تركیب بارهای مورد نظر از ابزار كدام منو استفاده 

1)Assign                     2 )Define      .  )Edit                 4 )Draw

118 

 ؟شودمیگاه گیردار به پای ستون از كدام دستور استفاده جهت اختصاص تکیه

1)Define> Restraints. )Assign>Restraints

2)Define>End (length)4 )Assign> End (length) offset

119 

 ؟كنیممیر و ستون بتنی از ابزار كدام منو استفاده در تی خوردگیترکجهت اعمال 

1)Assign2 )Define      .  )Edit                 4 )Draw

111 

 در تیرهای بتنی چقدر است؟ خوردگیترکمیزان 

1)51.0                               2 )510                            . )5160                              4 )5100

111 

 های بتنی چقدر است؟در ستون خوردگیترکمیزان 

1)51.0                               2 )510                            . )5160                              4 )5100 

112 

 ؟كنیممیلی انتخاب های معموینه را برای ساختمانبرای تنظیم درجات آزادی در هنگام آنالیز كدام گز

1)Full3D                        2 )Xzplane                 3 )Xg plan                        4) Noz Rotation 

113 

 گردد؟میزان ترم خوردگی در تیرهای بتنی حول كدام محور و به كدام خصوصیت اعمال می

1)Moment,.axis       2) Moment,2axis         .) Shear Area,.direction      4 )2و 1زینه گ

114 
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 گردد؟ای بتنی حول كدام محور و به كدام خصوصیت اعمال میهدر ستون خوردگیترکمیزان 

1)Moment,.axis       2) Moment,2axis         .) Shear Area,.direction      4 )2و 1زینه گ

115 

 ؟اندكدم snap toابزارهای 

 هاربایش محل تقاطع المان( .                       ها و محل تقاطع خطوط شبكهربایش گره(1

همه موارد( 4                                لمانربایش نقاط مرکزی و انتهای ا(2

116 

های دیگر نیز جزء كدامیک از روش eigenvectorsتحلیل دینامیکی علاوه بر روش  پارامترهایدر جعبه گفتگوی 

 باشد؟می  Etabsامکانات برنامه 

1)Relative Tolerance           . )Non-iterative base om mass

2)Reitz Vectors4 )Iterative- based on load combination

117 

 كنیم؟برای ساختن یک نمای دلخواه از كدام گزینه استفاده می

1)Draw>Draw debelop elevation definition
2)Draw>Draw line Object
.)Draw>Draw Section Cut
4)Draw>Draw Area Object

118 

 ؟كنیممیام گزینه استفاده برای تغییر زاویه قرارگیری اعضای قابی نسبت به حالت عادی از كد

1)Pier Labd2 )Local Axes . )Insertion Point                4 )Frame Section

119 

 ؟شودمیبه چه منظوری تعریف   wallبار 

 اعمال بار دیوارهای پیرامونی بدون بازشو )بدون نما((1

 )نمادار( اعمال بار دیوارهای پیرامونی دارای بازشو(2

 ها در طبقه آخراعمال وزن پارتیشن(.

 اعمال وزن نصف دیوارهای پیرامونی در طبقه آخر(4

121 

Splice point ها در پنجره اطلاعات طبقات چه كاربردی دارند؟ 

 .دهندمیدر آن طبقه + محل وصله ستون را نشان  هاستوندر آن  هاستونوجود یا عدم وجود نقاط وصله (1

 .دهندمیدر آن طبقه را نشان  هاستوندر آن  هاستونود نقاط وصله وجود یا عدم وج(2

 نشان دهنده نقاط اتصال تیر و ستون هستند.(.

 هیچكدام(4

121 

 ؟شودمیبرای معرفی سایز میلگردهایی كه در برنامه وجود ندارد از كدام مسیر اقدام 
1)Define> preferences >reinforcement bar sizes
2)Option> preferences >reinforcement bar sizes
.)Assign> preferences >reinforcement bar sizes
4)Display> preferences >reinforcement bar sizes

122 

Option Menu>Perferences>concrete frame design
 های بتنیطراحی سازهنامه معرفی آیین( .               های بتنیمترهای طراحی سازهامعرفی پار(1

های بتنیشاهده نتایج طراحی سازهم (4                     های بتنیشاهده نتایج تحلیل سازهم(2

123 

 ؟شودمیپس از اجرای كدام دستور فعال  lock modelحالت 

1)Design                       2) Assign                .) Display                         4 )Define

124 

 شودمیاز عملیات زیر انجام  یکكدام Replicateدستور 

 پاک کردن( .                  کپی وارد انتخاب شده در طبقات(1

امتداد دادن یک عضو( 4                                      دن عضو اضافهبری(2
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 ؟شودمیای از كدام دستور استفاده جهت تکثیر و كپی یک عضو به شکل دایره

1)Replicate>Linear           2)        Align>Trim. )Replicate>Redial4 )Align>Extend

126 

 ؟شودمیاستفاده  جهت تکثیر و كپی یک عضو به شکل خطی از كدام دستور

1)Replicate>Linear           2)        Align>Trim. )Replicate>Redial4 )Align>Extend

127 

 ؟شودمیجهت بریدن یک عضو خطی از كدام دستور استفاده 

1)Replicate>Linear           2)        Align>Trim. )Replicate>Redial4 )Align>Extend

128 

 ؟شودمیجهت امتداد یک عضو خطی از كدام دستور استفاده 

1)Replicate>Linear           2)        Align>Trim. )Replicate>Redial4 )Align>Extend

129 

 ؟شودمیمدول برشی مصالح چگونه تعریف 

 نامه و تعریف در قسمت معرف مصالحبه صورت دستی طبق آیین(1

 در برنامه وجود دارد فرضپیشبه صورت (2

 ددگرتوسط برنامه به صورت خودکار با توجه به دیگر مشخصات مصالح محاسبه و اعمال می(.

پس از تحلیل و طراحی قابل دسترسی است.(4

131 

 كنیم؟از چه روشی استفاده می Set Dynamic Parametersدر گزینه 

1)Eigen Values2) Eigenvectors          . )Ritz Vectors         4 )Modified Risk Method

131 

 رود؟بشمار نمی  Etabsافزارنرمهای كدامیک از موارد زیر از قابلیت

 میكی طیف پاسخ، دینامیكی تاریخچه زمانیتحلیل استاتیكی، دینا(1

 صورت دو و سه بعدیطراحی دیوارهای برشی به(2

 کنترل برش سوراخ کننده(.

 طراحی تیرهای مرکب(4

132 

 از مصالح و با چه كاربردی وجود دارد؟ یکكدامدر  Cost per Unit Weightگزینه 

1)Steel و قیمت واحد حجم فولاد                . )Conc و قیمت واحد وزن فولاد 

2)Steel 4                  و قیمت واحد وزن فولاد )Conc و قیمت واحد حجم بتن 

133 

 برای معرفی مصالح همگن كدام گزینه باید فعال باشد؟

1)Isotropic2 )Ortho tropic . )Homogen              4هیچكدام )

134 

 اند؟تعریف نشده Etabsافزار ع حالات بار زیر در نرماكدامیک از انو

یافتهکاهشبار زنده ( 4           بار قائم زلزله ( مؤلفه.                  بار باد( 2              بار زلزله افقی(1

135 

 در چیست؟ replicateو   copyگرهای لتفاوت استفاده از عم

 .شودمیمنتقل هم شكل و هم مشخصات replicateفقط شكل ترسیم شده منتقل شده ولی در copyدر فرآیند (1

 .شودمیهم شكل و هم مشخصات منتقل copyفقط شكل ترسیم شده منتقل شده ولی در replicateدر فرآیند (2

 در نمای جانبی قابل استفاده است.replicateدر پلان و  copyعملگر (.

 هیچكدام(4

136 

 توان دیوار یک سازه را انتخاب كرد؟با كدام ابزار زیر نمی

1)Select> By Wall Slab/Deck. )Select> link Properties

2)Select> By Area Object Type4 )Select> By Pier ID

137 

 توان به نقاط و اعضا وارد كرد؟علاوه بر نیروها چه نوع بارهای دیگری را می

2و  1گزینه ( 4         طولی بارهای( .          بارهای حرارتی( 2         بارهای جابجایی(1
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 پیغام زیر چه معنایی دارد و چه اقدامی باید كرد؟

Analysis ana design sections differ for 9 steel frames, do you want to select them

 تغییر داد.پیغام اعلام عدم تشابه مقطع تحلیل و طراحی در تعدادی از اعضا است و باید قفل را باز و مقاطع را (1

 کردن است. نظرصرفپیغام اعلام اختلاف جزئی مقطع تحلیل و طراحی در تعدادی از اعضا است که قابل (2

 تحلیل و طراحی تكرار شود. مجدداًپیغام اعلام عدم تشابه مقطع تحلیل و طراحی در تعدادی از اعضا است که باید (.

ی از اعضا است که باید قفل را باز کرده و مقاطع را تغییر داد.پیغام اعلام اختلاف جزئی مقطع تحلیل و طراحی در تعداد(4

139 

را  هاستون مؤثرهایی كه در یک سمت مهاربندی شده و از سمت دیگر بدون مهاربندی هستند، ضریب طول برای سازه

 به ترتیب چه مقداری وارد كنیم؟

1)1 , 1                         2 )1 , 5180                            . )5180 , 5180             4 )5180 , 1

141 

 در سازه چه تاثیری دارد؟ Gridنحوه ساخت

 کنداجزای سازه را تقویت می( .                                      هیچ تاثیری ندارد(1

سازه عملكرد مناسبی دارد. ر باربرجهت قرارگیری اعضای غی( 4              سازد.مسیر انتقال نیروها را ممكن می(2

141 

 ؟دهدمیچه عملی را انجام rigid Diaphragmگزینه 

 دهد.جهت اختصاص دیافراگم صلب که مرکز طبقه را نشان می(1

 دهد.جهت اختصاص دیافراگم صلب که مرکز جرم یک مجتمع را در آن نقطه نشان می(2

 تی تحلیل نمود.جهت حذف دیافراگم صلب از یک سازه تا بتوان آن را به راح(.

 جهت اضافه کردن چندین دیافراگم صلب تا میزان مقاومت سازه را نشان دهد.(4

142 

 كنیم؟برای معرفی سقف تیرچه و بلوک از كدامیک از انواع سقف زیر استفاده می

1)Filled Deck2 )Unfilled Deck. )Solid slab4 )Ribbed slab

143 

 باشد؟از چند روش قادر به محاسبه جرم ساختمان می Etabs افزارنرم

 محاسبه جرم ساختمان بر اساس جرم المان(1

 محاسبه جرم ساختمان بر مبنای ترکیب بارها(2

 تعیین شده به همراه ترکیبات بار هایجرممحاسبه جرم ساختمان بر اساس جرم المان و (.

 هر سه روش فوق(4

144 

Releasesدهد؟چه چیزی را به ما نشان می 

 میزان باربری اعضا( .             هاسقفمیزان گیرداری (1

میزان فشردگی اعضا( 4                           میزان آزادی(2

145 

 چه كاربردی دارد؟Auto Re label Allگزینه 

 مجدد کل اعضای سازه گذارینامو  گذاری( شماره.                        مجدد تیرها گذارینامو  گذاریشماره(1

اعضای ترسیمی جدید گذاری( نام4              گاهمجدد نقاط تكیه گذارینامو  گذاریشماره(2

146 

 حداقل ضخامت دال بتنی سقف تیرچه و بلوک چه مقدار است؟

 محدودیتی ندارد( 4                  مترسانتی 0( .               مترسانتی 6( 2                     مترسانتی 0(1

147 

 قابل انجام است؟ كاریچهview menu>measureبا استفاده از دستور 

 هاطول و مساحت و زاویه بین المان گیری( اندازه.                               هاطول المان گیریاندازه(1

 هامساحت و زاویه بین المان گیری( اندازه4                هاطول و زاویه بین المان گیریاندازه(2

148 

 توان استفاده كرد؟می Etabsمه اهای زیر در برنفرضپیشای با دال مشبک از كدامیک از برای ایجاد سازه

1)Steel deck. )Waffel slab

2)Tow way or ribbes slab                               4 )Flat Slab

149 
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 كنیم؟از كدام مسیر زیر عمل می هاآنبرای اتصال دو عضو خطی در یک نقطه مشخص پس از انتخاب 

1)Edit>Merge Points. )Edit>Join Lines

2)Edit>Align Points/Lines/Edges4 )Edite>Merge Point

151 

 ؟شودمیبرای معرفی تیرها و اتصالات قاب خشمی ویژه از كدام مسیر استفاده 
1)Assign>Frame/line> Moment Frame beam Type
2)Assign>Frame/line> End (length) Offsets
3)Assign>Frame/line> Frame Releases
4)Assign>Frame/line> Frame Out Put Stations

151 

 توانیم داشته باشیم؟می  (Master Storyختمان، چند طبقه مبنا )در یک سا

 حداقل دو طبقه( .                        فقط یک طبقه(1

 به تعداد طبقات ساختمان( 4                      حداکثر دو طبقه(2

152 

 داد؟ نوع فرآیند طراحی اعضای سازه را تغییر توانمیهای زیر كدامیک از گزینه وسیلهبه

1)Over Write Frame Design Precedure. )Live load Reduction

2)Steel Jois Design Precedure4 )Output Decimal

153 

ت ر قسمهای زیر داز گزینه یکكدامتوسط كاربر باید از  شدهمحاسبهبرای استفاده از توزیع ارتفاعی نیروی جانبی 

Auto Lateral Load انتخاب كرد؟ 

1)User Coefficient2 )User loads .)None                  4 )UBS70

154 

 كند؟در مرحله طراحی اولیه نحوه اتصالات را چگونه شناسایی می  Etabs افزارنرم

 غلطكی (4                       ریلی (.                           مفصلی (2                                 گیردار(1

155 

 باید مدل بشود؟ حتماًدر چه صورت خرپشته نیز 

 وزن بام بیشتر باشد. %05اگر وزن خرپشته از (1

 وزن بام بیشتر باشد. %05اگر مساحت خرپشته از (2

 وزن بام بیشتر باشد. %20اگر وزن خرپشته از (.

 وزن بام بیشتر باشد. %20خرپشته از  اگر مساحت(4

156 

 ؟شودمیضریب اصلاح سختی در كدام مورد وارد 

( همه موارد4                       ( مقاطع.                         دیوار (2                     هادال(1

157 

 كنیم؟فرعی انتخاب میهای كدام سقف زیر جهت پخش بارش عمود بر جهت تیرچه  Etabsدر برنامه 

 طاق ضربی( 4                     کرومیت (.                   کامپوزیت (2           تیرچه و بلوک(1

158 

 دهد؟آمده از طراحی را نشان می دست بههای زیر اطلاعات از گزینه یکكدام

1)Display tables. )Chenge design section

2)Display design info4 )Verify all members passed

159 

 در كدامیک از حالات زیر قابل مشاهده است. سازیمدل prespectiveعلاوه بر حالت 

1)Default . view       2 )Plan view. )Elevation view4 )همه موارد

161 
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 گزینه سوال گزینه سوال هگزین سوال گزینه سوال

1 1 41 4 81 1 121 2 

2 . 42 2 82 . 122 2 

. 2 4. 2 8. . 12. . 

4 1 44 1 84 4 124 . 

0 2 40 4 80 1 120 1 

6 . 46 . 86 1 126 . 

0 . 40 4 80 4 120 1 

8 1 48 2 88 . 128 2 

7 2 47 1 87 2 127 4 

15 1 05 2 75 2 1.5 . 

11 4 01 2 71 4 1.1 2 

12 4 02 2 72 . 1.2 . 

1. 1 0. 2 7. . 1.. 2 

14 1 04 1 74 4 1.4 1 

10 2 00 . 70 . 1.0 . 

16 4 06 . 76 1 1.6 1 

10 1 00 1 70 1 1.0 . 

18 . 08 1 78 4 1.8 4 

17 1 07 2 77 4 1.7 . 

25 2 65 2 155 . 145 1 

21 2 61 2 151 . 141 1 

22 1 62 4 152 4 142 2 

2. 2 6. 2 15. 1 14. 1 

24 4 64 2 154 1 144 . 

20 . 60 1 150 4 140 2 

26 2 66 . 156 1 146 . 

20 2 60 4 150 . 140 1 

28 4 68 1 158 2 148 . 

27 4 67 1 157 . 147 . 

.5 2 05 . 115 1 105 2 

.1 1 01 4 111 1 101 1 

.2 1 02 . 112 2 102 4 

.. 2 0. 1 11. 1 10. 1 

.4 1 04 1 114 1 104 2 

.0 1 00 1 110 4 100 1 

.6 2 06 . 116 4 106 . 

.0 4 00 . 110 2 100 2 

.8 2 08 . 118 1 108 2 

.7 . 07 1 117 2 107 2 

45 2 85 2 125 45 165 . 
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